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Dieses Handbuch enthält Informationen und Verfahren zur Installation des PA 800 Plus
EmpowerTM Driver. Der PA 800 Plus EmpowerTM Driver ermöglicht die Datenerfassung von
einem PA 800 Plus Pharmaceutical Analysis-System mit der Waters EmpowerTM 3 (FR4)
Software. Der PA 800 Plus EmpowerTM Driver muss auf demselben Computer wie die Waters
EmpowerTM Software installiert sein.
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Betriebssystemvoraussetzungen
Diese Version der Software ist kompatibel mit Microsoft Windows 10 (64-Bit). Die
Computeranforderungen finden Sie unter: Computer-Anforderungen.

Computer-Anforderungen
Der Computer muss die Mindestanforderungen für Microsoft Windows 10 (64-Bit) erfüllen.
Weitere Informationen finden Sie in der Dokumentation von Waters.

Ein freier USB-Anschluss ist ebenfalls erforderlich.

Validierte Controller-Konfiguration
Tabelle 2-1 Validierte Controller-Konfiguration

DetailsElement

Microsoft Windows 10 Enterprise 2016 LTSBBetriebssystem

• Oracle Client Version 12.1.0.2.0 für 32-Bit

• Waters EmpowerTM Software

• National Instruments Driver, Version 19

Zusätzliche Software

Minimum: CPU für Windows 7 oder 10 Intel 2 Duo, E6400
2,13 GHz

Empfohlen: Intel Core 2 Duo, E8400 3,0 GHz

CPU

Minimum: 4 GB
Empfohlen: 8 GB

RAM (Arbeitsspeicher)

Minimum: 25 GBFestplatte

2 GB für die Waters EmpowerTM SoftwareFreier Speicherplatz

Minimum: 1024 × 768 Auflösung (außer LAC/E-Module)
Empfohlen: 1920 × 1080 Auflösung für Client

Monitor
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Tabelle 2-1 Validierte Controller-Konfiguration (Fortsetzung)

DetailsElement

Serieller Hub mit 8 PortsOptionale Steuerschnittstellen

1 Ethernet-Adapter für Netzwerkkonnektivität
Minimum: Mehr als 100 MBit/s
Empfohlen: 1 GBit/s

Ethernet-Adapter

Benötigte Software
Die Waters EmpowerTM 3 Software muss installiert sein. Der PA 800 Plus EmpowerTM Driver
wurde mit der Waters EmpowerTM 3 (FR4) Software validiert.

Während der Early Access-Kundenevaluierung bewerteten Kunden den PA 800 Plus EmpowerTM

Driver und stellten fest, dass er vollständig mit der Empower EmpowerTM 3 (FR2) Software
oder höher kompatibel ist.

Für zusätzliche Datenverarbeitungsfunktionen:

• Um qualitative Analyseberechnungen für SDS-MW- und cIEF-Anwendungen durchzuführen,
ist die Waters EmpowerTM GPC-Software erforderlich.

• Um standardmäßige Pharmakopöe-Berechnungen (z. B. Auflösung oder Rauschen und
Abweichung) durchzuführen, ist die Waters EmpowerTM System Suitability Software
erforderlich.

Wenden Sie sich an einen Waters Vertriebspartner, um eine Lizenz für die jeweilige Software
zu erwerben.

Erforderliche PA 800 Plus Firmware-Version
Der PA 800 Plus EmpowerTM Driver wurde auf Systemen mit den folgenden Versionen der PA
800 Plus-Firmware validiert. Siehe Tabelle 2-2.

Tabelle 2-2 Validierte PA 800 Plus Firmware-Versionen

Firmware-VersionPA 800 Plus-System

10.2.3PA 800 Plus-System nicht nach ROHS
zertifiziert

10.2.5-RROHS-zertifiziertes PA 800 Plus-System

10.3.7-RCESI 8000 Plus-System

Wenn es sich bei der PA 800 Plus-Firmware nicht um eine der validierten Versionen handelt,
dann ist ein Upgrade erforderlich, um sicherzustellen, dass der PA 800 Plus EmpowerTM Driver
mit der Waters EmpowerTM Software und den SCIEX Tools für die Durchführung einer
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Betriebsbedingungsprüfung kompatibel ist. Siehe Bestimmen der Firmware-Version mithilfe
der Waters EmpowerTM Software.

Bestimmen der Firmware-Version des PA 800 Plus Systems
Bestimmen der Firmware-Version mithilfe der Waters EmpowerTM Software

1. Öffnen Sie die Waters EmpowerTM Software und klicken Sie dann auf Run Samples.
2. Wählen Sie das korrekte System aus und klicken Sie auf OK.
3. Klicken Sie auf View > System.

Abbildung 2-1 Dialogfeld „System Information“

4. Klicken Sie auf Scan Instruments.
Wenn die Spalte OK? „Yes“ anzeigt, dann kommuniziert der Treiber mit dem
LAC/E-Modul.

5. Blättern Sie nach rechts zur Spalte Details.
Die Firmware-Version wird mit weiteren Details zum System angezeigt.
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Abbildung 2-2 Firmware-Version

Wenn die Firmware aktualisiert werden muss, wenden Sie sich an einen SCIEX
Vertriebsmitarbeiter.

Bestimmen der Firmware-Version mithilfe der 32 Karat Software

1. Öffnen Sie die 32 Karat Software.

2. Wählen Sie das korrekte Gerät aus, um sich anzumelden.

Hinweis: Stellen Sie sicher, dass das PA 800 Plus-System und der Controller
miteinander kommunizieren.

Abbildung 2-3 Fenster der 32 Karat-Software

3. Klicken Sie auf Control > Instrument Status > View.
4. Blättern Sie zum Suchen der Firmware-Version nach unten.
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Abbildung 2-4 Firmware-Version

Wenn die Firmware aktualisiert werden muss, wenden Sie sich an einen SCIEX
Vertriebsmitarbeiter.
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Suche nach bereits installierten Treibern
1. Stellen Sie fest, ob der Treiber für Beckman Coulter PACE MDQ Control for Waters

Empower installiert ist.

a. Klicken Sie auf Control Panel > Programs and Features.
b. Suchen Sie nach Beckman Coulter PACE MDQ Control for Waters Empower

Software.
Falls diese Software vorhanden ist, deinstallieren Sie sie. Siehe Deinstallation des
Beckman Coulter PACE MDQ Control for Waters Empower Software Driver.

2. Stellen Sie fest, ob die richtige Version des National Instruments Software-Treibers
installiert ist.

Hinweis: Der PA 800 Plus EmpowerTM Driver erfordert Version 19.0 des National
Instruments Software Driver. Wenn eine andere Version installiert ist, muss diese
entfernt werden.

a. Klicken Sie auf Control Panel > Programs and Features.
b. Suchen Sie nach National Instruments Software.

Wenn die Versionsnummer nicht 19.0 ist (oder keine Versionsnummer angezeigt
wird), deinstallieren Sie die Software. Siehe Deinstallieren früherer Versionen des
National Instruments Software-Treibers.

Deinstallation des Beckman Coulter PACE MDQ
Control for Waters Empower Software Driver
1. Schließen Sie alle offenen Waters EmpowerTM Software-Programme.

2. Klicken Sie auf Control Panel > Programs and Features.
3. Klicken Sie aufBeckman Coulter PACEMDQControl forWaters Empower software

und dann auf Uninstall/Change.
Das Fenster „InstallShield Wizard“ wird geöffnet.

4. Klicken Sie auf Remove und dann auf Next.
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Abbildung 3-1 InstallShield Wizard für Beckman Coulter PACE MDQ Control for
Waters Empower

5. Klicken Sie in der daraufhin geöffneten Meldung auf Yes, um alle Funktionen zu
entfernen.

6. Wenn die Deinstallation abgeschlossen ist, klicken Sie auf Finish, um das Fenster
„InstallShield Wizard“ zu schließen.

7. Klicken Sie in der Systemsteuerung unter „Program and Features“ mit der rechten
Maustaste, wählen Sie Refresh, und stellen Sie sicher, dass Beckman Coulter PACE
MDQ Control for Waters Empower software nicht mehr angezeigt wird.
Wenn der Treiber weiterhin in der Systemsteuerung angezeigt wird, wiederholen Sie
den Vorgang, um den Treiber zu deinstallieren.

Deinstallieren früherer Versionen des National
Instruments Software-Treibers
Hinweis:Der PA 800 Plus EmpowerTMDriver erfordert Version 19.0 des National Instruments
Software Driver. Wenn eine andere Version installiert ist, muss diese entfernt werden.
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1. Klicken Sie auf Control Panel > Programs and Features.
2. Klicken Sie auf National Instruments Software und dann auf Uninstall/Change.

Das Fenster National Instruments Software wird geöffnet.

3. Führen Sie je nach installierter Treiberversion einen der folgenden Schritte aus:

• Halten Sie Strg+Umschalt gedrückt, drücken Sie den Abwärtspfeil, um alle Elemente
in der Liste auszuwählen, und klicken Sie dann auf Remove.

Abbildung 3-2 National Instruments Software Uninstall (Dialogfeld)

• Klicken Sie auf Remove All.

Abbildung 3-3 National Instruments Software Uninstall (Dialogfeld)

4. Wenn die Deinstallation abgeschlossen ist, klicken Sie auf Yes, um den Computer neu
zu starten.

5. Melden Sie sich nach dem Neustart des Computers an.
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Installation des PA 800 Plus EmpowerTM Driver
Hinweis: Der PA 800 Plus EmpowerTM Driver muss auf dem Citrix-Server installiert sein,
wenn der PA 800 Plus EmpowerTM Driver in der Citrix-Umgebung ausgeführt wird.

1. Legen Sie die DVD für den PA 800 Plus EmpowerTM Driver in das DVD-Laufwerk ein.

2. Navigieren Sie zum Ordner „PA 800 Plus Empower Driver V1.3.0“, und doppelklicken
Sie dann auf setup.exe.
Das Dialogfeld „Open File - Security Warning“ wird geöffnet.

3. Klicken Sie auf Run.
Der PA 800 Plus EmpowerTM Driver InstallShield Wizard wird geöffnet.

Abbildung 3-4 Sciex PA 800 Plus EmpowerTM Driver InstallShield Wizard

4. Klicken Sie auf der Seite „License Agreement“ auf I accept the terms of the license
agreement und dann auf Next.

5. Folgen Sie den Anweisungen auf dem Bildschirm, um die Software zu installieren.
Übernehmen Sie bei Aufforderung die Standardwerte. Wenn zu Beginn der Installation
Warnungen angezeigt werden, ignorieren Sie diese.
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Installation des National Instruments Software
Driver
Für den PA 800 Plus EmpowerTMDriver ist der National Instruments Software Driver Version 19.0
erforderlich.

1. Navigieren Sie auf der Installations-DVD für den PA 800 Plus EmpowerTM Driver zum
Ordner „NI-488.2 19.0 Driver“ und doppelklicken Sie dann auf Install.exe.
Das Dialogfeld „Open File - Security Warning“ wird geöffnet.

2. Klicken Sie auf Run.
Das Installationsprogramm sucht nach Lizenzvereinbarungen und öffnet dann die
folgende Seite.

Abbildung 3-5 Installationsassistent „NI Package Manager“

3. Klicken Sie auf I accept the above 2 license agreements. und anschließend auf Next,
bis sich die Seite „NI Package Manager“ öffnet.

4. Klicken Sie in der Liste Additional items you may wish to install auf NI-488.2 .NET
Language Runtime 17.0.1 for .NET Framework 4.5 und klicken Sie dann auf Next.
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VORSICHT: Möglicher Kommunikationsfehler. Stellen Sie sicher, dass die
Komponente NI-488.2 .NET Language Runtime 17.0.1 for .NET Framework 4.5
ausgewählt ist, bevor Sie auf OK klicken. Wenn die Komponente nicht installiert
ist, dann ist eine Kommunikation zwischen dem LAC/E-Modul und dem PA 800
Plus-System nicht möglich.

Hinweis: In dieser Liste sind standardmäßig noch weitere Komponenten ausgewählt.
Sie sind ebenfalls erforderlich und sollten ausgewählt bleiben.

Abbildung 3-6 Erforderliche .NET-Komponenten

5. Klicken Sie auf der Seite „Agree“ auf I accept the above 2 license agreements. und
dann auf Next.

6. Klicken Sie auf der nächsten Seite auf I accept the above 2 license agreements. und
dann auf Next.
Die Installation kann einige Minuten dauern.
Wenn die Installation abgeschlossen ist, wird eine Meldung zum NI Update Service
angezeigt.
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Abbildung 3-7 Meldung „NI Update Service“

7. Klicken Sie auf No.
8. Wenn das Installationsprogramm eine Meldung zum NI Customer Experience

Improvement Program anzeigt, klicken Sie auf No, I do not want to participate in the
NI Customer Experience Improvement Program und dann auf OK.

9. Klicken Sie auf Reboot Now, um den Computer neu zu starten.

10. Melden Sie sich am Computer an.

Hinweis:Wenn ein Dialogfeld zur Registrierung der Software geöffnet wird, klicken
Sie auf Cancel, um es zu schließen.
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Gehen Sie wie folgt vor, um die Waters EmpowerTM Software für die Zusammenarbeit mit dem
PA 800 Plus-System zu konfigurieren.

Ändern der Druckeinheiten
Die Waters EmpowerTM Software kann den Druck in psi- oder Millibar-Einheiten anzeigen.
Standardmäßig ist die Einheit Millibar. Die Druckeinheiten können über die LAC/E-Workstation
oder den Citrix-Server geändert werden.

Gehen Sie wie folgt vor, um die Einheiten zu wechseln.

1. Melden Sie sich als Benutzer mit Administratorrechten am Computer an.

2. Schließen Sie die Waters EmpowerTM Software.

3. Öffnen Sie das Fenster „Registry Editor“.

a. Klicken Sie auf Start, geben Sie R ein und klicken Sie dann auf Run.
Das Dialogfeld „Run“ wird geöffnet.

b. Geben Sie regedit ein.
c. Klicken Sie in der angezeigten Meldung auf Yes.
Das Fenster „Registry Editor“ wird geöffnet.

4. Suchen Sie den Registry-Eintrag für die Druckeinheiten.

a. Klicken Sie auf Edit > Find.
b. (Optional) Klicken Sie in der Baumstruktur auf den Ordner HK_LOCAL_MACHINE.

Tipp!Die Suche nach demEintrag ist viel schneller, wennHK_LOCAL_MACHINE
ausgewählt ist.
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c. Geben Sie im Feld Find what: PressureUnitPSI ein und klicken Sie dann auf Find
Next.

Abbildung 4-1 Dialogfeld „Find“

Die Suche kann einige Zeit dauern. Wenn der Schlüssel gefunden wird, wird er im
rechten Fensterbereich des Fensters „Registry Editor“ angezeigt.

Abbildung 4-2 Registry Editor

5. Bearbeiten Sie den Registry-Eintrag.
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a. Doppelklicken Sie auf „PressureUnitPSI“.
Das Dialogfeld „Edit DWORD (32-Bit) Value“ wird geöffnet.

Abbildung 4-3 Dialogfeld „Edit DWORD (32-Bit) Value“

b. Geben Sie im Feld Value data den Wert für die Einheiten ein, und klicken Sie dann
auf OK.
• 1 für psi
• 0 für mbar

c. Klicken Sie auf File > Exit , um die Änderungen zu speichern und schließen Sie das
Fenster „Registry Editor“.

Konfigurieren des Erfassungsservers
Hinweis: Richten Sie den Erfassungsserver in der Waters EmpowerTM 3 (FR4) Software ein,
bevor Sie das folgende Verfahren abschließen. Anweisungen finden Sie in der Dokumentation
des Herstellers, die mit der Software geliefert wurde.

1. Doppelklicken Sie auf das Symbol Empower auf dem Desktop, und melden Sie sich
als Benutzer mit Administratorrechten an.

2. Klicken Sie im Dialogfeld „Waters EmpowerTM software Start“ aufConfigure the System.
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Abbildung 4-4 Dialogfeld Waters EmpowerTM Software Start

Das Fenster „Configuration Manager“ wird geöffnet.

Hinweis: Die Liste der Knoten in der folgenden Abbildung zeigt die lokale Konfiguration
der Waters EmpowerTM Software.
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Abbildung 4-5 Fenster „Configuration Manager“

3. Klicken Sie in der Tabelle mit der rechten Maustaste auf den zu konfigurierenden Knoten,
und wählen Sie Properties.
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Abbildung 4-6 Dialogfeld „Node Properties“, Registerkarte „General“

4. Klicken Sie auf die Registerkarte „Configure DHCP“ und klicken Sie dann aufConfigure
DHCP.
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Abbildung 4-7 Registerkarte „Configure DHCP“

Das Dialogfeld „Waters DHCP Server Configuration“ wird geöffnet.
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Abbildung 4-8 Dialogfeld „Waters DHCP Server Configuration“

5. Wenn der Beckman Coulter PACE MDQ Control for Waters Empower Software Driver
bereits installiert war, löschen Sie alle vorhandenen CE-Instrumente in der Liste. Klicken
Sie im Dialogfeld auf BCPACEMDQ und anschließend auf Remove.

6. Klicken Sie auf Add.
Das Dialogfeld „Add IP Address“ wird geöffnet.

7. Aktualisieren Sie die Felder im Dialogfeld wie folgt.

Abbildung 4-9 Dialogfeld „Add IP Address“

a. Lassen Sie das Feld IP Address leer. Es ist für ein PA 800 Plus System nicht
erforderlich.
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b. Lassen Sie das Feld MAC Address leer. Sie ist nicht erforderlich und wird
automatisch auf 00-00-00-00-00-00 eingestellt.

c. Klicken Sie auf Instrument Type, und wählen Sie PA800PLUS aus der Liste aus.

d. Geben Sie im Feld Serial Number/Unique Name 1 ein.
e. Klicken Sie auf OK.
Wenn eine Meldung zur MAC-Adresse angezeigt wird, schließen Sie die Meldung, geben
Sie eine beliebige Zahl in das Feld MAC Address ein, und klicken Sie dann auf OK.

8. Wenn der Beckman Coulter PACE MDQ Control for Waters Empower Software Driver
bereits installiert war, klicken Sie auf die Registerkarte Instruments.

Abbildung 4-10 Registerkarte „Instruments“

9. Löschen Sie alle zuvor konfigurierten Instrumente, die mit dem Beckman Coulter PACE
MDQ Control for Waters Empower Software Driver verknüpft sind.
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a. Klicken Sie auf die Zeile mit dem zu löschenden Instrument und dann auf Remove
Instrument.
Bei zuvor konfigurierten Instrumenten ist in der Spalte Type BCPACEMDQ
angegeben.

Abbildung 4-11 Bestätigungsmeldung

b. Klicken Sie in der angezeigten Meldung auf Yes und in der nachfolgenden Meldung
wieder auf Yes.

c. Wenn in der Spalte Type weitere Instrumente mit BCPACEMDQ vorhanden sind,
wiederholen Sie den Vorgang, um sie zu löschen.

10. Klicken Sie auf OK.
Das Dialogfeld „Node Properties“ wird geschlossen.

11. Wenn ein zweites PA 800 Plus System an das LAC/E-Modul angeschlossen werden
soll, wiederholen Sie diesen Vorgang mit Ausnahme von Schritt 7. Geben Sie 2 im Feld
Serial Number/Unique Name ein.
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Hinweis: Die zusätzlichen Schritte, die für die Einrichtung des zweiten PA 800 Plus
Systems erforderlich sind, müssen von einem SCIEX Außendienstmitarbeiter
durchgeführt werden. Kontaktieren Sie den technischen Support von SCIEX unter
sciex.com/request-support.

Einrichten eines neuenChromatographiesystems
Die Waters EmpowerTM Software wurde für die Chromatographie entwickelt. Daher wird jedes
an die Software angeschlossene Instrument als „chromatographisches System“ bezeichnet.
Das PA 800 Plus-System muss als chromatographisches System konfiguriert werden, bevor
es verwendet werden kann.

1. Klicken Sie im Fenster „Configuration Manager“ auf File > New > Chromatographic
System.

Der „New Chromatographic System Wizard“ wird geöffnet.

Abbildung 4-12 Seite „Type Entry“

2. Klicken Sie auf Create New System und dann auf Next.
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Hinweis: Die Liste der Knoten in der folgenden Abbildung zeigt die lokale Konfiguration
der Waters EmpowerTM Software.

Abbildung 4-13 Seite „Select Server“

3. Klicken Sie auf den Knoten mit dem PA 800 Plus System und dann auf Next.
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Abbildung 4-14 Seite „System Selection“

4. Klicken Sie in der Liste Available Instruments auf der linken Seite auf PA800PLUS#1,
ziehen Sie es in die Liste New System Instruments auf der rechten Seite, und klicken
Sie dann auf Next.

5. Aktualisieren Sie die Felder auf der Seite wie folgt.
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Abbildung 4-15 Seite „Access Control“

a. Share System with Other Network Users: Wählen Sie diese Option aus, um
anderen Netzwerkbenutzern Zugriff auf das System zu gewähren.

b. Allowed Access: Wählen Sie die Benutzertypen aus, die auf das System zugreifen
dürfen. Zur Auswahl stehenOwner Only,Owner andGroup(s) oderOwner, Group,
and World. Wählen Sie für die beiden letztgenannten Gruppen die Gruppen in der
Liste Allow Access to Group(s) aus.

c. Allow Access to Group(s): Wählen Sie die Gruppen aus, denen der Zugriff auf das
System erlaubt ist.

Es muss mindestens eine Gruppe ausgewählt werden.

d. Password Protect System Access: Wählen Sie Password Required, um ein
Kennwort erforderlich zu machen. Geben Sie in die Felder Password und Confirm
Password das Kennwort mit bis zu 30 Zeichen ein.

e. Klicken Sie auf Next.
6. Aktualisieren Sie die Felder auf der Seite wie folgt.
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Abbildung 4-16 Seite „Name Selection“ im „NewChromatography SystemWizard“

a. System Name: Geben Sie den Namen des Systems mit bis zu 30 Zeichen ein. Der
Name wird in der „Empower“-Datenbank und im Fenster „Configuration Manager“
verwendet.

b. Online: Aktivieren Sie dieses Kontrollkästchen, um das neue System online zu
schalten.

c. System Comment: (Optional) Geben Sie Kommentare oder andere
Identifikationsdaten für das System mit bis zu 250 Zeichen ein.

d. Klicken Sie auf Finish.
e. Wenn eine Meldung über ein in einem anderen Online-System konfiguriertes

vorhandenes System angezeigt wird, klicken Sie auf OK.

Definieren der Puffer- und Probentrays
In der Waters EmpowerTM Software werden die Proben- und Puffertrays im PA 800 Plus System
als „Platten“ bezeichnet. Die Platten müssen in der Waters EmpowerTM Software definiert
werden. Um diesen Prozess zu vereinfachen, stellt SCIEX Textdateien mit den erforderlichen
Informationen zur Verfügung, die importiert werden können.

1. Legen Sie die DVD für den PA 800 Plus EmpowerTM Driver in das DVD-Laufwerk ein.
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2. Klicken Sie im Dialogfeld Waters EmpowerTM software Start aufConfigure the System.

Das Fenster „Configuration Manager“ wird geöffnet.

3. Klicken Sie auf Plate Types, um die bereits definierten Platten anzuzeigen.

Abbildung 4-17 Plattentypen im Fenster „Configuration Manager“

4. Erstellen Sie die Platte für das Puffertray.

a. Klicken Sie mit der rechten Maustaste in die Tabelle, und wählen Sie Import from
Text.

b. Klicken Sie aufBrowse und navigieren Sie dann zur Datei PA800Plus Buffer Tray.txt
auf der DVD für den PA 800 Plus EmpowerTM Driver.

Hinweis: Für den Fall, dass die DVD nicht verfügbar ist, ist eine Kopie der Datei
in diesem Dokument enthalten. Kopieren Sie den Inhalt, und fügen Sie ihn in eine
Textdatei ein. Siehe Plattendefinitionsdateien.

c. Geben Sie PA 800 Plus Buffer Tray im Feld New Plate Type Name ein und klicken
Sie auf OK.
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Abbildung 4-18 Dialogfeld „Import Plate Type From Text File“

Die Pufferwanne wird zu der Liste im Fenster „Configuration Manager“ hinzugefügt.

5. Wiederholen Sie Schritt 4, um die Probentrays zu erstellen.

• Wählen Sie für das Probentray mit 48 Probenflaschen die Datei PA800Plus Sample
Tray.txt aus, und benennen Sie dann die Platte mit PA 800 Plus Sample Tray.

• Wählen Sie für das 96-Well-Probentray die Datei PA800Plus 96Well Sample Tray.txt
aus, und benennen Sie dann die Platte mit PA 800 Plus 96 Well Sample Tray.

Für das Puffertray: Wenn die Plattendefinitionsdatei nicht verfügbar ist, enthält dieses
Dokument eine Kopie. Siehe Plattendefinitionsdateien.

Hinweis: Die Plattendefinitionsdatei für die 96-Well-Probenplatte ist für eine
Standard-SCIEX-96-Well-Mikrotiterplatte (Art.-Nr. 609844) vorgesehen. Wenn Sie eine
96-Well-Mikrotiterplatte eines anderen Herstellers verwenden möchten, klicken Sie im
Fenster File > New > Plate Type auf Configuration Manager, und definieren Sie
die Platte manuell.

6. Wenn der Beckman Coulter PACEMDQ Control for Waters EmpowerTM Software Driver
bereits installiert ist, löschen Sie alle Platten, die für die Verwendung mit diesem Treiber
erstellt wurden. Klicken Sie mit der rechten Maustaste auf die Reihennummer für die
Platte, und wählen Sie Delete.

7. (Optional) Um detaillierte Informationen zu einer Platte anzuzeigen, klicken Sie mit der
rechtenMaustaste auf die Reihennummer für die Platte, und wählen Sie dannProperties.

8. (Optional) Klicken Sie mit der rechten Maustaste auf die Reihennummer für die Platte,
und wählen Sie Delete.
Nur Platten, die von einem Benutzer hinzugefügt wurden, können gelöscht werden.
Vordefinierte Platten können nicht gelöscht werden.
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9. Klicken Sie auf File > Exit, um das Fenster Configuration Manager zu schließen.
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• Wenn dasGPIB-Schnittstellenkabel vom LAC/E-Modul getrennt wird, geht die Kommunikation
mit dem PA 800 Plus-System verloren. Schließen Sie das GPIB-Schnittstellenkabel an, und
starten Sie das LAC/E-Modul neu.

• Bei einer Probensatzmethode werden alle Werte im Feld Injection Volume ignoriert.
Stattdessen verwendet die Waters EmpowerTM Software den Parameter Duration für das
Injektionsereignis, um das Injektionsvolumen zu bestimmen.

• Bei einer Inject Pressure Capillary Fill wird ein Fehler verursacht, wenn sample lid für
dieWannenpositionen ausgewählt wird. Wählen Sie stattdessenSample alsWannenposition
aus und setzen Sie die Fläschchen-Inkrementierung auf 1.

Hinweis: Der Benutzer muss eine spezifische Methode programmieren, wenn zu einem
Fläschchen zurückgekehrt werden muss.
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Dieser Abschnitt enthält die Plattendefinitionen für das Puffertray, das Probentray und das
SCIEX 96-Well-Probentray. Diese Platten müssen in der Waters EmpowerTM Software definiert
werden.

Die Dateien sollten als Teil der Installation des PA 800 Plus EmpowerTMDriver installiert werden.

Wenn sie fehlen und die Platten definiert werden müssen, kopieren Sie den Text, fügen Sie
ihn in einen Texteditor ein, und speichern Sie die Datei.
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Definitionsdatei für PA 800 Plus-Puffertray
Empower Profile for Plate Type: CE Buffer Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 85.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 9.00
  Top Left Well Y Location: 9.00
  Well Diameter: 12.00
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 6
  Row Spacing: 13.40 mm
  Number of Columns: 6
  Column Spacing: 13.40 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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Plattendefinitionsdatei für
PA 800 Plus-Probentray
Empower Profile for Plate Type: CE Sample Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 128.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 9.00
  Top Left Well Y Location: 17.10
  Well Diameter: 12.00
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 8
  Row Spacing: 13.40 mm
  Number of Columns: 6
  Column Spacing: 13.40 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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Plattendefinitionsdatei für PA 800 Plus
96-Well-Probentrays
Empower Profile for Plate Type: 96-Well Sample Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 128.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 11.00
  Top Left Well Y Location: 14.50
  Well Diameter: 6.80
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 12
  Row Spacing: 9.00 mm
  Number of Columns: 8
  Column Spacing: 9.00 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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Kundenschulung
• In Nordamerika: NA.CustomerTraining@sciex.com

• In Europa: Europe.CustomerTraining@sciex.com

• Die Kontaktinformationen für Länder außerhalb der EU und Nordamerikas finden Sie unter
sciex.com/education.

Online-Lernzentrum
• SCIEX Now Learning Hub

Kauf von Verbrauchsmaterial
Die Neubestellung von SCIEX-Verbrauchsmaterialien erfolgt online unter store.sciex.com.
Verwenden Sie zum Einrichten einer Bestellung die Kontonummer, die im Angebot, in der
Auftragsbestätigung oder in den Versanddokumenten zu finden ist. Der SCIEX-Onlineshop ist
derzeit auf die USA, Großbritannien und Deutschland beschränkt, wird aber in Zukunft auf
andere Länder erweitert. Kunden in anderen Ländern wenden sich bitte an ihren lokalen
SCIEX-Vertreter.

SCIEX Support
SCIEX und seine Vertretungen beschäftigen weltweit einen Stab an ausgebildeten Servicekräften
und technischen Spezialisten. Der Support kann Fragen zumSystem oder anderen auftretenden,
technischen Problemen beantworten. Weitere Informationen finden Sie auf der SCIEX-Website
unter sciex.com, oder kontaktieren Sie uns unter:

• sciex.com/contact-us

• sciex.com/request-support

Cybersicherheit
Die aktuellsten Hinweise zur Cybersicherheit von SCIEX-Produkten finden Sie unter
sciex.com/productsecurity.
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Dokumentation
Diese Version des Dokuments ersetzt alle vorherigen Versionen.

Für die Anzeige des Dokuments wird der Adobe Acrobat Reader benötigt. Um sich die neueste
Version herunterzuladen, besuchen Sie https://get.adobe.com/reader.

Softwareproduktdokumentationen entnehmen Sie den Versionshinweisen oder dem mit der
Software mitgelieferten Software-Installationshandbuch.

Informationen zur Hardware-Produktdokumentation finden Sie auf der mit dem System oder
der Komponente gelieferten Customer Reference-DVD.

Die neuesten Versionen der Dokumentationen sind auf der Website von SCIEX unter
sciex.com/customer-documents verfügbar.

Hinweis:Wenn Sie eine kostenlose gedruckte Ausgabe dieses Dokuments wünschen,
wenden Sie sich bitte an sciex.com/contact-us.
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